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What is Knit Visualizer?  
Knit Visualizer was created to make it easy for you, the knitter/designer, to create charts from a stitch 
pattern and modify those charts easily.  Why charts?  Charts give you a chance to understand how a 

stitch pattern looks, what two repeats side by side look like before you ever sit down with needles and 
yarn.  Want to change where you start knitting the pattern? That is much easier to do when you can see 

which stitches line up on top of each other in a chart and how the repeats interact with each other. 

 
Knit Visualizer contains an extensive palette of knitting stitches that you can easily paint onto your chart.  

From lace, complex cables and color work*, you can do it all easily. The symbols are clear and easy to 
read. You can easily zoom in/out to determine the best viewing size for your particular chart. 

 
The Knit Visualizer parser will interpret a stitch pattern and build the chart for you. This gives you an 

excellent starting point for combining different patterns, changing the edge stitch/pattern or whatever 

you need to do to make the pattern work for your project. 
 

Printing is a snap with multiple layout options for the chart, auto-generated legend, notes and more. A 
Print Preview screen shows exactly how your chart will look on paper.  Printouts can be scaled down to fit 

more on a page, or scaled up to make the chart easier to read.  A large notes area for each chart will let 

you put special instructions, even a full pattern with your chart.   Chart, title, author, notes, and Chart 
Properties (including font size, row number preferences) are saved in your save file. 

 
For the creative person - Knit Visualizer can also be used to chart out weaving treadle sequences, cross 

stitch charts, any type of pattern that requires a grid to organize the symbols. 
 

If you are new to knitting using charts, be sure to check out the tutorial available from The Knit Foundry 

website http://www.knitfoundry.com/freestuff.html 

How to Read this Manual 
The manual covers installation, use of the software and a lot of tips and tricks.  Throughout the 
document you might see these items: 

 

 
This will be in front of a tip that will help you navigate a 
window or dialog using keyboard shortcuts. 

 

 

Information about the application 

k2p2 
Text displayed like this is meant to be typed into the Pattern 
Entry text field. 

 
This icon means a difference in the application for Mac users 

 

Please read through this manual before using Knit Visualizer. Many of your questions will be answered 

here.  For Frequently Asked Questions (FAQs) and other related items, please see 
http://www.knitfoundry.com/software.html 

                                                
* All charts are black and white. Charts for color knitting are created using different black and white 
symbols for each color.  Future versions of Knit Visualizer will most allow you to use color. 
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Installation 
 
Knit Visualizer is available on two platforms: Windows & Mac OS X.  Instructions for installation on your 

specific platform can be found here.  The instructions for installing the Demo and the full application are 
the same. You can install the full application on top of the Demo; it will replace the necessary files to 

enable all features. 

Windows Vista: Download and CD 
System Requirements: 

Disk Space  approx 65MB 

Memory   512MB or more recommended 
Screen Resolution  1024x768 

 
The Vista installation is very similar to that of Windows XP, with a few exceptions: 

 
• To install into the default C:\Program Files\Knit Visualizer location you need to have 

administrative rights on your computer.   If you are not an administrator, right click the 

installation .exe file and select “Run as Administrator”.  You will need to know the username and 

password of an administrative user to continue.  If you don’t have administrative rights you can 
install it anywhere else that you have permissions. 

• The charts directory is no longer created for you under C:\Program Files\Knit Visualizer 

Vista doesn’t let mere mortals write into this area of the file system, so your file save dialog 
should default to opening into your Documents directory.  

 

While the version for vista has been labeled 1.2a; the core code for Knit Visualizer remains the same and 
all previously found defects are still included.  When you first run the installer, Vista will show you a 

dialog that says “An unidentified program wants access to your computer” and say it’s from an Unknown 
Publisher.  This is normal. Click “Ok” to continue with the installation. 

 

Windows XP: Download and CD 
System Requirements: 

Disk Space  approx 65MB 
Memory   512MB or more recommended 

Screen Resolution  1024x768* 

 
Older processors (more than a few years old) might have difficulty running Knit Visualizer due to the 

graphics-intensive nature of the application.  More memory is always recommended and will improve the 
performance of Knit Visualizer accordingly.  A dedicated video card isn't required; but even one that has 

64MB of memory will improve your system's performance while running Knit Visualizer. 

 
Once you have the installation exe file (either via download, or on a CD), browse to the file and double 

click it to begin the installation.   Below you will find the important screens in the installation process, 
with an explanation of their purpose.   If you received Knit Visualizer on CD, the CD should auto-play the 

installation program for you when you insert it into your CD drive on your computer.  If not, browse to 
the CD, and open the Windows directory. Double click the exe file to begin the installation. 

                                                
*
 The current version of Knit Visualizer is set to startup at 1024x768 resolution.  To force it into 800x600 follow these steps: 

• Run Knit Visualizer 
• Right click on the task bar and select Task Manager OR you can use Control-Alt-Delete to get to it 
• Make sure the Applications tab is selected  
• Find the Knit Visualizer entry, and right click on it. Select “Maximize”.  
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License agreement 

You must agree to the license 
in order to install Knit 

Visualizer.  Selecting "I accept 

the agreement" will enable the 
Next button. 

 

Destination Directory 

Select where you would like to 

install Knit Visualizer. The 

default is C:\Program 
Files 

 

Select Components 

You are required to install the 
Program & Libraries.  Installing 

the Sample Charts is optional. 
It is recommended to install 

the Sample Charts so you will 

be able to view some pre-
existing charts to get an idea 

of what you can create in Knit 
Visualizer. 

 

 

Select Start Menu Folder 

In Windows, you access 
programs from the Start 

button, All Programs Menu.  

The default name of the folder 
placed there is Knit Visualizer. 
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Select File Associations 

You can choose to associate 
the extension .kct with Knit 

Visualizer.  This will allow you 
to open the application by 

double clicking on a saved 

chart file. 

 

 

Select Additional Icons 

You can create a desktop icon, 
and/or a quick launch icon.  If 

you unselect both of these, 
you will still be able to access 

Knit Visualizer from the Start 

button, All programs menu. 

 

 

Finish 

After a progress dialog 
displays the files being copied, 

you will be shown this last 

screen. You can run Knit 
Visualizer immediately from 

this screen. 
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Mac OS X   
 
System Requirements:  

Mac OS X 10.4 

Administrator privileges are recommended 
Disk Space approx 5MB 

Memory  512MB or higher recommended 
Screen Resolution  1024x768 

 

In order to use Knit Visualizer on your Macintosh,  you must first verify the proper system files are 
available.  Using the Finder, find the path: "Applications � Utilities � Java" 

You should see J2SE 5.0 listed.  If not, follow these directions to install the proper files 

You can download the JDK from the apple site at 
 

http://www.apple.com/support/downloads/java2se50release3.html 
 

(There might be a later version available, Check http://developer.apple.com/java/download/ for info) 

 
When the download completes, you'll be prompted if you want to continue installing or not. Select 

"Continue" several times, Agree to the license agreement, Continue until prompted for the Administrator 
password (enter it). You should finish with a message "The software was successfully installed" 

 

You can also use the Software Update mechanism to find and install the new version of Java.  Refer to 
the documentation included with your computer for how to use the Software Update tool. 

Install Knit Visualizer on Macintosh: Download 

You will download a file named* KnitVisualizer 1.2.dmg .  After the download is complete, your 

system should automatically mount the file as a drive for you.   As the file is mounted, you will be 
prompted to agree to the license to use Knit Visualizer (unless you're installing the Demo).   Agree to the 

license, and once the file is mounted, open the Finder application and open the mounted drive, to find 

see the Knit Visualizer app and the Sample Charts directory.   Simply drag the application to your desired 
location.  If you use /Applications, then you will need to authenticate as an administrator on your 

computer.   If you use your user ~/Applications directory, you won't need admin privs.   You may copy 
the Sample Charts directory to anywhere on your system. 

Install Knit Visualizer on Macintosh: CD 

Put the CD into your CD drive. Open the Knit Visualizer CD icon. You'll see a Mac OS X directory. Browse 
to that directory, then simply drag the Knit Visualizer application to the desired location. If you use 

/Applications, then you will need to authenticate as an administrator on your computer.   If you use your 
user ~/Applications directory, you won't need admin privs.   The Sample Charts directory at the root of 

the disk is valid for both Windows and Mac systems - You may copy the Sample Charts directory to 

anywhere on your system. 
 

Once the installation is complete, you can Eject the temporarily mounted drive from the File menu. 

                                                
* Version number might be different 
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Running the program 

Windows XP 
 

Double click the Knit Visualizer.exe file from the Windows File Explorer, or click on the desktop or quick 

launch icon created during installation.  The splash screen will appear while the application is being 
loaded. Once the main window is visible, you may begin editing and creating charts. 

Mac OS X 
Browse to where you installed the application and double click the icon. The splash screen will appear 
while the application is being loaded.  Once the main screen appears, you may begin editing and creating 

charts. 
 

A note on keyboard shortcuts: Throughout the manual, keyboard shortcuts will be listed for most 

operations.  They will be listed as "Control-<key>". On the mac substitute "Command" for the word 
"Control" and the shortcuts will work as described. 

 

UnInstalling Knit Visualizer 
To uninstall Knit Visualizer, simply find the Knit Visualizer Uninstaller (on Windows).  Double click the 
item, and follow the prompts.  Any charts you have created or altered in your Knit Visualizer program 

directory will remain after uninstallation.  Please note you will not be able to read .kct files once the 

program is uninstalled. 
 

For Mac OS X, you simply drag the application to the trash can.  
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Change History 
This section details out changes made to Knit Visualizer since the original release.  More recent changes 
are listed first. 

 
Version 1.2a (Windows version and Manual) 

• Made Knit Visualizer 1.2 compatible with Vista. 

• Documentation in Manual about installing on a Vista system. 

• All other features remain the same – there have been no updates to the Knit Visualizer software 

itself; just the installation. 

 
To determine if you have the 1.2a version of Knit Visualizer, navigate to the Help -> About Knit 

Visualizer window. You should see VISTA in the date of the build. 
 

Version 1.2 (of Manual) August, 25, 2006 
• Added information about screen resolution 

 

Version 1.2, August 9, 2006 

• Added Insert menu with commands to Insert Column(s) to the Right/Left & Insert Row(s) 

above/below 
• Added stitch definition for sl2kwk1p2sso (was missing previously) 

• Added new stitches: k4tog, k5tog, k6tog, k7tog, p4tog, p5tog, p6tog, p7tog, nupp, incr4, incr5, 

incr6, incr7 

• Changed Stitch Palette to separate knit related decreases from purl related decreases 

• Bug fix: Exception being thrown when parsing a multi-cell stitch on as a wrong side row 

• Bug fix: pattern instructions generated for multi-cell stitches were incorrectly counting number of 

times to repeat the stitch.  
• Enhanced pattern instruction generation to recognize when a multi-cell stitch is interrupted by 

another stitch and change instructions accordingly 

• Changed Chart Preferences to Chart Properties to better describe what it does 

• Added Application Preferences to allow user to set stitch used when deleting cells, and inserting 

new rows/columns 
 

Version 1.1 

• Mac OS X version available 

• Added ability to generate written out instructions from your chart from the Preview window 

• Modfied layout of Print Preview Window, set default view percentage to 50% 

• Added key bindings for common commands in the File menu 

• New Chart Preferences Key Binding : Control-[  (left square bracket) 

• Cancel out of Preview, Print Preview, Chart Preferences dialogs using the Escape key 

• Changed key bindings for increase/decrease font size from arrow keys to +/- keys 

• Added Border Keybindings (using the keystroke is just like pushing the button): 

o Control-T  Add Top Border to current selection 
o Control-B  Add Bottom Border to current selection 

o Control-R  Add Right Border to current selection 
o Control-L  Add  Left Border to current selection 

o Control-0 (that's a zero), Remove all borders from within the current selection 

o Control-; (that's a semicolon), Add borders around all edges of the current selection 
• Added binding to "S" key. Type S to switch between paint and select mode. Keep an eye on your 

cursor to see which mode you're currently in 

• Remember the last Layout used in the Preview window; even after quitting Knit Visualizer 

• New Symbols: make 1 right, make 1 left 
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• On startup, re-loads the last chart you were working on when you quit  



Knit Visualizer 1.2a Manual   Page 12 of 47 

Copyright 2005 -2007 © The Knit Foundry 
http://www.knitfoundry.com 

Learning the Main Window 
There are several different areas of the screen that you should familiarize yourself with, as shown in 
Figure 1.  
 

 
Figure 1: Knit Visualizer Main Window 

 

1. Chart area 
2. Pattern Instruction Entry area 

3. Title Bar, shows location of file and indicator if file is unsaved 
4. Menubar & Toolbar 

5. Stitch Palette 

6. Status Bar 
 

This Manual will cover everything you need to know to create charts with Knit Visualizer. As a quick 
overview, you work with the chart in the Chart Area (1), selecting/copying/inserting rows, columns and 

cells, painting stitches and other operations.  Each cell in the chart represents one stitch in your knitting. 

Sometimes it's a combination of stitches that make up a more complex stitch, such as a cable. 
 

You use the Pattern Entry (2) area to type in pattern rows such as "k1 p2 (k2tog yo) 5 times".   
 

The Stitch Palette (5) is what you use to select the stitches to paint in the Chart Area.  
 

The Status Bar (6) gives you information about the size of your current selection, the currently selected 

stitch and the font size used to display the chart on the screen and when printed. 
 

When the application first starts up, the chart area will either contain a blank 10x10 chart, automatically 
created or you, or the last chart that you had open (as long as it was also successfully saved).   If the 

chart area is empty (such as it would be after creating a New chart with 0 rows and 0 columns, or using 

the Clear Chart command), there is still a chart present – it just happens to contain no rows or columns.  

   1 

2       

3 

4 

5 

6 
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It is often best to begin using the Pattern Entry area with an empty chart.   Alternately you can create a 

'blank canvas' chart, that contains all knits, purls or Empty stitches from the New Chart dialog. Read the 
relevant sections for more details on how to use Pattern Entry and the Chart drawing tools. 

Menus & Toolbar buttons 
All the commands you need to access can be found either in the menus and/or in the toolbar.  Many of 

these commands have keyboard shortcuts associated with them.  This section will go over each of these 

commands and tell you what they do.  While most of these commands are common to most software 
applications, there is information here that goes beyond how to open a file. 

 
Each section also lists the keyboard shortcut, if there is one, for that command.  On Windows system this 

shortcut will always start with Control. Mac OS X users would use Cmd (the fully little apple symbol) 
instead.  Also, on the Mac OS X platform, some menu items are included in a menu that is named "Knit 

Visualizer" instead of on the File or Help menus. 

 Knit Visualizer Menu – About Knit Visualizer 
[ Mac only ] This command performs the same task as described below in the Help Menu – About Knit 

Visualizer. 

 Knit Visualizer Menu – Preferences 
[ Mac only ] This command performs the same task as described in View Menu – Application Preferences. 
 

 Knit Visualizer Menu – Quit Knit Visualizer 
[ Mac only ] Exits the application, prompting you to save the current chart if unsaved changes have been 
made.  

 

 Command-Q will invoke this command 

File Menu –  New Chart   
Creates a new chart with prefilled cells. 

 

 
Figure 2: New Chart Dialog 

 

You can enter the number of rows and columns, and a default stitch for each cell to contain.  To create 
an empty chart when you want to use the Pattern Entry mode, enter 0 (zero) for both # of Rows and # 

of Columns. 
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Before creating a new chart you will be prompted to save the existing chart if there were unsaved 
changes. 

 

 Use the Tab key to move between fields. The Enter key will close the dialog, as if you had pressed the 

"Ok" button.  Use the space bar to select a radio button, once you have tabbed to it. 

File Menu –   Open…  
This allows you to open a chart you have previously saved to your file system.  Knit Visualizer chart files 

all have the kct extension.  By default, charts are saved in the charts directory inside the Knit Visualizer 

installation; but you can store them anywhere on your file system. 

 
If the existing chart is unsaved, you will be prompted to save it before opening another one. 

 

 Keyboard Shortcut: Control-O will invoke the Open command 

File Menu – Open Recent 
Knit Visualizer keeps track of the last ten charts you opened/saved in this list for you to easily choose a 

recently opened file.  Selecting a filename from this list will open the file.   As always, if the currently 
displayed chart has not been saved, you will be prompted to save it before opening the new chart. 

File Menu –   Save and   Save As… 
At any point when working on a chart, you can save it to your file system as a .kct file. This allows you to 
work on the chart again later, or share it with your friends who also have Knit Visualizer. If the chart has 

already been saved once, using "Save" will save it again to the same location.  "Save As…" lets you give a 

new filename to the chart.  All charts are saved with the "kct" filename extension. 
 

 Keyboard Shortcut: Control-S will invoke Save when you are in the main window. 
 

You can tell if a chart has not been saved by looking at the Knit Visualizer's title bar.  The filename of the 
current chart is shown there.  A chart that has never been saved will be shown as "untitled".  If the chart 

has been saved, the filename will be shown, and an asterisk (*) will be in front of the filename when it 
has not been saved. 

 

 
Figure 3: Title Bar showing unsaved changes 

 

At any time if you try to do something that would close the current chart with unsaved changes, you will 
be shown this dialog: 
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Figure 4: Unsaved Changes Dialog 

 
Answer "Yes" to be prompted for a place to save the chart. "No" means don't save, and continue 

whatever task prompted the dialog.  "Cancel" will abort the task (such as Exiting the program) and take 
you back to the main window, leaving the unsaved chart still open.   

 

It is always a good idea to save your work often in case the cat happens to walk across the keyboard, or 
your dog steps on the power plug and turns the machine off. 

 

 To dismiss the dialog without using your mouse, use the Tab key to navigate to the desired button. 
Press the "Space" key to invoke that button. 

 

Don't try and open a kct file with a text editor. It's a binary format that is only 

understood by Knit Visualizer.  You could corrupt your file and lose all your hard 
work.  If you still want to take a peek inside, that's OK (I understand, really!), 

but make sure to not save it after opening it outside Knit Visualizer.  

File Menu –   Page Setup 
The Page Setup dialog lets you view and change printing related options. You can select a paper size & 

source, the Orientation of the chart on the page, the margin sizes and the printer to use.  The specific 

options available in this screen are dependent on your operating system and printer options available.  
Changes made in the Page Setup dialog are in effect until you close Knit Visualizer.   

 
You must close the Page Setup dialog either via the OK or Cancel buttons before you can go back to the 

main Knit Visualizer window. 

 
Figure 5: Page Setup Dialog 

 

File Menu –   Print… &   Export as PNG 
The two menu items Print… and Export as PNG both open the same dialog, the Preview Dialog.  This 
is to allow you to choose what items you want included in your printout or image file. (See Figure 6). 
Both are included in the File menu to remind you of these important features. 
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 Keyboard shortcut: Control-P will bring up the Preview window 
 
By default the Preview Dialog shows the Title, Source, Chart, Legend and Pattern text.  These field values 

are entered in the Chart Properties dialog (See the View Menu –  Chart Properties section for more 
details).   A scroll bar shows up along the right side of the window if there is more information than can 

easily fit on the screen.   Knit Visualizer tries to make the Preview Dialog as big as it can if you have a 
large chart. This is to show you as much as possible, and minimize the amount of scrolling you need to 

do. 

 
Figure 6: Preview Dialog 

 

The size of the symbols in the Preview Dialog chart is the same size as the Main Window chart.   If you'd 

like the chart to be smaller on paper, close the dialog, change the font size using the  toolbar button, 
then select Print… again.  The smaller the font, the more chart will be able to fit on one piece of paper.   

 

Uncheck or check the appropriate checkboxes to affect what you see in the Preview Dialog. What you see 
on this screen is exactly what will be printed, exported or copied to the clipboard.   

 

Field Description 

Title 
The title is displayed in a larger font across the very 

top of the chart. 

Source 
The source of the chart, in a smaller font than the 

title, displayed directly under the title. 

Chart The chart itself. 

Notes The notes entered in the Chart Properties Dialog. 

Legend 

The legend for the stitches in the chart. Only stitches 

included in the chart are displayed.  Uncheck this box 
to hide the legend.   The amount of information 

placed in the Legend is determined by the row 
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numbering options in the Chart Properties dialog. 

Simple 
Legend 

If selected, the legend will not display knitting 
directions for any of the stitches. This option has no 

effect unless the Legend is displayed. 

Pattern* Printed instructions to knit the chart. 

 

All the auto generated information shown in this dialog is based on the row numbering options chosen in 
the Chart Properties dialog.  The legend will show instructions for knitting a symbol on both the right and 

wrong sides if the pattern is not circular and wrong side rows are shown in the chart.  The pattern 

instructions will mark the first right side and wrong side row as appropriate and the wrong side rows will 
contain the wrong side version of the stitch to knit (sometimes this is the same as the right side version, 

as in a yarn over) 

Layouts 

Knit Visualizer provides you with several layouts to choose from in the Preview Dialog.  The default layout 

is Vertical.  Select a different layout in the dropdown to change the layout, the effect is immediate and 
you will see the new layout.  Here is a summary of the different layout types.†   

 

Vertical 

Source

Chart

Legend

Notes

Title

Pattern

 

 

                                                
* New in version 1.1 
† All charts generated by Knit Visualizer using "Copy to clipboard" and resized to fit on the page 
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Vertical, 

Centered 

Source

Chart

Legend

Notes

Title

Pattern

 

 

Vertical, 
Wide 

Source

Chart

Legend Notes

Title

Pattern

  

Horizontal 

Source

Chart Legend

Notes

Title

Pattern
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Horizontal 

(Long 
Legend) 

Pattern

Source

Chart

Legend

Notes

Title

 

 

We've shown the layout maps in color so you can see how each element type changes position.   If an 
element is unselected in the Preview Dialog (eg. the notes or legend) that area will not be shown and the 

elements below the hidden ones will move up to take over that space.  

 
The layout you choose depends on how many different symbols are included in your chart, the font size, 

note contents, and the chart width.  Play around with the different layouts to find one that looks good 
with your charts. 

Export 

You can create a PNG file from the Preview Dialog.  Click the "Export…" button and you will be prompted 
for a location to save the file. PNG files use the .png file extension.   PNG stands for "Portable Network 

Graphic" and is a form of compressed image file that offers better quality than both GIF and JPEG.  Once 
the file is saved to your hard drive, you can open it with any graphics imaging software, web browser, or 

similar application.* 

 

Using PNG files is one of the best ways to include a Knit Visualizer chart in your 

own knitting pattern. Once you have created the PNG file, you can insert it into 

your pattern (in Microsoft Word, or any other editor that accepts image files) and 
resize it according to the space available.  Also check out "Copy to Clipboard" 

that skips the save to disk step. 

Copy to Clipboard 
For pattern designers, both Export and Copy to Clipboard will be extremely useful features.  When writing 

your pattern, you want to include your chart in the pattern.  Once you have the chart looking exactly as 

you want it to, select "Copy to Clipboard".    You now have in your clipboard buffer your chart (and 
whatever else you decided to show) ready to be pasted into your document.†  All of the charts shown in 

the Layout section above were inserted using Copy to Clipboard. 

                                                
* On very small charts, sometimes the image file created has a bit of extra white space around it. If space 

is tight where you are using the image, use any basic drawing program to crop out the extra white areas. 
† This has been tested on Windows XP, with Microsoft Office 2003.  If you have an older version of 

Microsoft Word, Copy to Clipboard might not work for you. Export to a PNG file first, then include that 
image in your document. 
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Print Preview 

You can print directly to your printer using the Print button, or you can see how it will fit on the page(s) 
by using the Print Preview feature.  Clicking the Print Preview button will show you this window: 

 

 
Figure 7: Print Preview window 

 
The Preview Dialog closes when you bring up the Print Preview window.  From this window you can 

perform the following tasks: 
 

Task Description 

Page Setup View and change paper size, orientation, margins, etc.  This is 
the same command as File -> Page Setup 

Print Print the document as shown 

Close Close the dialog without doing anything 

View Page at % Select a percentage for viewing the pages. The smaller the 

percentage the more pages on the screen at once. 

Print Scale % Change the scale of the chart in the printout. This lets you 
squeeze the chart onto less pages. 

 

Note that the Print Preview is fairly memory intensive as it has to render each page. When you change 
the Page or Print scale percentages, all pages are re-rendered at the specified values. 

Print 

You can print directly from the Preview Dialog without going through the Print Preview window by 
clicking the Print button.  It will use the options as last set in the Page Setup dialog and print exactly 

what you see in the Preview Dialog. 
 



Knit Visualizer 1.2a Manual   Page 21 of 47 

Copyright 2005 -2007 © The Knit Foundry 
http://www.knitfoundry.com 

Knit Visualizer places a header on the top of each printed page containing the page number out of total 

number of pages, and the save location of the chart file, if the chart has been saved. 

File Menu – Exit 
[ PC only ] When you choose this option, you are closing Knit Visualizer.  If the chart you've been 

working on isn't saved – you will be given a chance to save it before exiting.   You can also exit the 
application by clicking on the "x" in the upper right corner of the Main Window (on Windows machines) 

or the red circle on a Macintosh. 

Edit Menu Concepts 
Many of the Edit menu commands are only available when there is something selected in the chart; or 

when a previous selection has been copied or cut into the buffer.  For details on how to select cells, rows 
or columns in your chart, see the Select Mode section.  
 

A selection can be either a selection of rows, columns or individual cells. All selections are contiguous, 
meaning that you can only have one group of rows/columns/cells selected at one time, and only one type 

of selection at one time.  There is an off-screen storage space, the buffer, where a temporary copy is 
stored when you do a Copy or Cut.  This section of the Manual will explain details and limitations on each 

operation. 

Edit Menu –   Undo  
Many operations in Knit Visualizer can be undone by clicking the Undo button or menu item.  Any 

alterations to the chart: painting, deleting, inserting, pattern entry parsing (once it has been entered into 
the chart) can be undone. If you close your chart without saving, that can not be undone.  You are given 
50 levels of undo.  

 
Some operations only count as one undo, even though it might have affected more than one cell in the 

chart.  For instance, when you use the Shift key to paint the same symbol many times; all of the symbols 
painted while holding the mouse down are part of the same undo action. 

 

 Keyboard shortcut: use Control-Z to invoke Undo 

Edit Menu –  Redo  
Once you have invoked the Undo command, you will be able to Redo that same command.  If you Undo, 
then Redo – it is as if you didn't invoke either.   

 

 Keyboard shortcut: use Control-Y to invoke Redo 

Edit Menu –  Cut,  Copy  &   Paste  
All of these operations require that something a selection be present in the chart.   

 

Cut will make a copy of the current selection into the buffer, and replace everything in the selection with 
the "No Stitch" symbol. 

 
Copy will copy the contents of the current selection into the buffer. 

 
Paste will fill the current selection with the contents of the copy-buffer.  If the selection is larger than 

what the buffer contains, Knit Visualizer will repeat the buffer across and/or down to fill the space.  You 

may not paste rows into a column Selection and vice versa, but you can paste cells into either row or 
column selections. 
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 Keyboard shortcuts: Cut = Control-x   Copy = Control-c   Paste = Control-v  

Edit Menu – Insert 
This command has been moved to the Insert menu as of version 1.2. 

Edit Menu – Duplicate 
Duplicates the current rows/columns selection to the top/right of the chart.  You cannot duplicate a 

selection of cells.   
 

 Keyboard shortcut: use Control-D to invoke Duplicate 

Edit Menu –  Delete 
Deletes the current selection.  For cell selections, all cells are replaced with the "No Stitch" symbol.  For 
row and column selections, the selected rows/columns are deleted out of the chart completely. 

 

 Keyboard shortcut: use the Delete key to invoke Delete 

Edit Menu – Clear Chart 
To create a completely empty (no rows, no columns) new chart, select Clear Chart. If the current chart 
has unsaved changes, you will be prompted to save them.  This command has the same effect as File -> 

New Chart and entering 0 for both # of Rows and # of Columns. 

Edit Menu – Mirror Selection (Horizontal & Vertical) 
You can take the contents of a selection, and have Knit Visualizer mirror it vertically or horizontally. When 

you invoke Mirror, it takes the current selection and flips it around in the specified direction.  This is not 
the same as rotating the selection.  Note the position of the purl stitches in the following diagrams: 

 

  

 

Original Chart Mirrored 
Horizontally 

 

   
   

   

Original 
Chart 

 

Mirrored 

Vertically 

  

 

 

Some caveats on using Mirror - Horizontal.  If you attempt to mirror a cable stitch, it will flip around the 
symbols inside the cable, and it won't look like anything useful when it's done: 

 

 Cable Before 
 

After Mirror 

Horizontal  
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Vertical Mirroring doesn't have that problem, as there will be no stitches spanning rows. 

 
Mirroring works on any type of selection. 

Insert Menu Overview 
The insert menu contains commands that allow you to insert new rows or columns into your chart.  All of 
the New Column or New Row commands work with whatever is currently selected in the chart. They will 

not be enabled if you do not have column(s) or row(s) selected respectively. 

Insert Menu – Insert Copied Rows/Columns 
This command is the only one on the Insert menu that requires you to have previously Copied a 

selection. It will not be enabled unless you have copied a selection of Rows or Columns, since this 
command does not work on cell selections.   

 

NOTE: This is the same command that was on the Edit menu as "Insert" prior to version 1.2.  For clarity 
it has been renamed and moved 

 
Inserts the buffer into the chart based on the current selection's topmost cell (for rows) or left most cell 

(for columns).  Only works if you have copied full row(s) or column(s) into the buffer.   
 

 Keyboard shortcut: use Control-I to invoke Insert 

Insert Menu – New Columns to the Right/Left 
Once a column selection has been made, you can now insert new columns to the right or left.  However 

many columns are selected is how many new columns will be created.  For instance if you have 1 column 
selected, and choose "New Columns To the Right", a single column will be inserted to the right of your 

current selection.  If you have 3 columns selected, and choose New Columns to the Left, then 3 new 
columns will be created to the left of your selection.  The new column(s) will be selected when the 

operation is complete. 

Insert Menu – New Rows Above/Below 
To insert new rows into your chart, select one or more rows, then choose New Rows Above or New Rows 

Below.  Just like with the New Columns command, however many rows you have selected will determine 

the number of rows created.  The newly created rows will now be selected in the chart. 

Format Menu – Increase & Decrease Font 
You can change the size of the font used to display the symbols in the chart using the Increase/Decrease 

Font commands.  The font size is saved with the chart; so when you re-open the chart, it will have the 
same font size it did when you saved it. 

 

 Keyboard shortcut: Control-+ to increase font size, and Control-- to decrease the font size. 

Format Menu – Justify 
The items in the Justify menu only affect a chart that has the No Stitch included in it, and then only if 

those are on the edge. First though, we need to know what a "No Stitch" is. 
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The No Stitch Concept 

In some charts, all the cells in the chart are real stitches. In other charts, the final piece has shape, such 
as in a sleeve, or a triangular shawl.  Some lace patterns have increases on one row, and decreases on 

another row.  To make the yarn-overs line up and look more like the final knitting, we need the ability to 

say "skip this space, it doesn't really exist" on those rows that have the decreases.  Knit Visualizer uses 
the "No Stitch" symbol to represent these areas. 

 
The Justify commands only affect a chart if there are No Stitch cells on the outside edges of the chart.  

Knit Visualizer decides how to allocate the No Stitch cells, based on the desired Justification.  We will use 
an example chart to show the differences as you select the different Justifications.  

Original 

Chart 

 

 None Leave Justification as is. No changes to the chart, 
however the No Stitch cells are placed. 

 Left   

 

Justify with all symbols to the left, and No Stitches to 

the right 

 

 Center 

 

Justify with No Stitches to the left and right, balanced 
as possible. If there are an odd number of No Stitch 

cells, one side will have an extra No Stitch, but it will 

always be the same side. 

 

 Right 

 

Justify with all the symbols to the Right, and all No 
Stitches to the left 
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If there were any No Stitch cells in the center of the chart, those would be ignored, no matter what the 

justification setting.  It is only the No Stitch cells on the left and right edges that are affected by the 
justification setting. 

 
Keep in mind the purl stitches in the example could be anything; knits, increases, decreases and so on. 

Format Menu – Borders 
Many knitting charts like to indicate repeats within the chart by a line; or on very large charts mark every 
10 columns and 10 rows.  You can also use borders to help emphasize the cables in your cable patterns.  

See Figure 8 below. 

 
Figure 8: Cable Pattern that uses borders for emphasis 

 

Each of the Border buttons operates on the current selection, and with the exception of the Borders – 
None command, will add the border indicated by the command.  

 

 None For every cell in the selection (not just edge cells), 

remove all borders from those cells. 

 Control-0 (zero) 

 All Draw borders around the outside perimeter of the 
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selection. Interior cells are ignored. 

 Control-; 

 Left Draws a border on the left side of the selection 

 Control-L 

 Top Draws a border on the top side of the selection 

 Control-T 

 Right Draws a border on the right side of the selection 

 Control-R 

 Bottom Draws a border on the bottom side of the selection 

 Control-B 

 

View Menu –  Chart Properties 
Each chart you create in Knit Visualizer has a set of properties associated with it.  In addition to changing 

the settings related to the row numbering, you may add a Title, Source, and Notes for a chart.  See 
Figure 9 for what this window looks like. 

 

 
Figure 9: Chart Properties Dialog 

 

Each of the options modifies the way the row numbers are displayed in the chart. No actual chart rows 
are removed if the row numbering options are changed; just the location of the row numbers.  Chart 

Properties are saved with your chart save file, so when you open the chart again later, all the options will 
be reloaded as well.  If you create a New chart, the Chart Properties will remain as currently set until 

they are edited.  Click the Ok button to save the changes made in this dialog, and see them affect the 

chart.  Click Cancel to close the dialog without saving any changes. 
 

Circular pattern 
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When this option is selected, the row numbers are all displayed on the right side of the chart, and the 

Legend generated in the Preview Dialog only includes knitting instructions for Right Side rows.  This 
signals to the knitter to knit every row from the front side, since you begin knitting each row on the side 

where the row number is.    When the chart is marked as a Circular Pattern, All of the options under the 
Flat Pattern Options section will be disabled; as they will have no effect on the chart's row numbers. 

 

Flat Pattern 
If the Circular Pattern checkbox isn't checked, then the chart will be represented as a flat pattern.  Row 

numbers will be included on both sides of the chart, according to the next two options. The Legend will 
be generated with both Right and Wrong side knitting instructions. 

 
Odd # Rows on Right Side of Chart 

This option is only applicable if the Circular Pattern checkbox is unselected.  If this option is checked, 

then the chart will have the first row as #1 on the right (which is most common).   When this option is 
unchecked, row #1 will be on the left. 

 
Hide Wrong Side Rows 

When this option is selected, it means that wrong side row numbers are not included in the chart.  No 

rows are removed, only the row numbers are adjusted to reflect this option.  If this option is selected, 
then there are no Wrong Side rows included in the chart, so the Legend generated in the Preview Dialog 

will not include Wrong Side instructions. 
 

Show Grid Lines 
You can hide the grid lines in the chart.  

 

Show Symbol for Empty Stitches 
The No Stitch stitch can also be called an empty stitch.  The empty stitch will be depicted as an X on a 

grey background if this option is selected.   If this option is not selected, then No Stitch cells will be 
shown with only the grey background, and no X symbol. 

 

Title 
You can give your chart a title, by entering the text in this field. This title is displayed when you Print or 

Export your chart. 
 

Source 

It's always a good idea to give credit to the original pattern source.  You can list your name, the book 
and pattern the chart is based on, or any other information desired.  This information can be displayed 

when you Print or Export your chart. 
 

Notes 
This area is for any notes related to knitting the chart. This can include information on where repeats 

begin and end, suggested yarn, even the text of a pattern to knit using the chart. The notes can be 

displayed when you Print or Export your chart. 
 

 Keyboard shortcut: use Enter to save preferences and close the dialog. Use the Tab key to move 
between fields.  Use Control-[ to open the Chart Properties dialog 

View Menu – Application Preferences 
New in v1.2! There are a few settings that affect more than just a single chart. You will find those options 

here. 
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Figure 10: Application Preferences Dialog 

 

Setting Stitch used when deleting cells: When you select some cells (not rows or columns) and hit the 
Delete key, the application removes all the symbols associated with those cells. It has to fill the cells with 

something, and by default it fills with No Stitch symbols.  If you'd like to always fill cells with something 
else, such as a knit stitch, change the option here. You can select from knit, purl and No Stitch. 

 

Setting Stitch used when adding new Columns/Rows: Inserting empty rows by default will contain the 
knit stitch, you may decide to use a knit, purl or No Stitch by selecting it here. 

 
All application preferences are remembered even after closing Knit Visualizer.  If you Clear Preferences 

from the About Knit Visualizer dialog, these settings will go back to their defaults. 

 
Pressing cancel will abort any changes you made in the dialog.  Pressing OK will cause the selections to 

go into effect immediately. 
 

 Keyboard shortcut: use Control-comma to open this dialog quickly. 

View Menu – Hide Pattern Entry Fields 
To give as much space as possible on the screen to the chart, you can hide all the pattern entry fields.  
Simply select the Hide Pattern Entry Fields checkbox and the Pattern Entry fields are hidden from view.  

To show them again, select Hide Pattern Entry Fields again (which will uncheck the checkbox, and show 

all the fields) 

View Menu – Themes 
For Windows versions of Knit Visualizer the colors used to display the Main Window, dialogs and chart 

elements are controlled by the current Theme selected.  Each Theme has a slightly different set of 
colors.*  The default Theme choice you will see the first time you run Knit Visualizer is the Blue Ice 

Theme.   The application will remember the last Theme you selected; and start with that Theme the next 
time you run.  The currently selected theme is indicated by the selected Radio Button in the View Menu. 

 

The Theme also affects the colors used in the chart that is printed/exported.   The theme for the Mac 
version of Knit Visualizer will match the look and feel of the Mac operating system, and cannot be 

changed.  

 
 

                                                
* Differences in monitors may affect the actual colors you see when you run Knit Visualizer. 
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Default Theme 

Will most closely match 
the look of the operating 

system. Example shown at 
right is on the Windows 

platform. 

 

Silver Moon Theme 

 

Blue Moon Theme 

 

Green Dream Theme 
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Blue Ice Theme 

 

 

Help Menu – About Knit Visualizer 
To learn what version of Knit Visualizer you have installed, and where to get support, open the About 
dialog.  Figure 11 shows an example About dialog. The text within this dialog may be different in your 

version of Knit Visualizer. 

 

 
Figure 11: About dialog 

 
Information from the About dialog might be needed if you have questions or need support.  Click the Ok 

button to close the dialog. 
 

The Clear Prefs button will clear out any application preferences saved, including the chosen theme, and 

recent files list.  Preferences are not required for Knit Visualizer to function properly, but they are 
designed to make it easier to use.  Note that the Recently Opened files list is not cleared out completely 

unless you close Knit Visualizer immediately after clearing the application prefs.  Application Preferences 
are saved for you automatically as you perform actions (such as select a different Theme) in Knit 

Visualizer. 

Toolbar Buttons 
The toolbar provides quick access to the most often used actions in Knit Visualizer. You can hold your 

mouse pointer steady over a button to see a quick tool tip with information on what that button does.  

The following table shows each toolbar button, and a short description of what it does. 
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 Creates a new chart 

 Open a chart from your hard drive 

 Save the chart to the hard drive 

 Print/Export chart 

 View Chart Properties 

 Undo last edit 

 Redo last undo action 

 Copy selection 

 Cut selection 

 Paste selection 

 Delete selection 

 Zoom out, make the font smaller 

 Zoom in, make the font larger 

 Select mode 

 Paint mode 

 Justify, None 

 Justify, Center 

 Justify, Left 

 Justify, Right 

 Border, Remove all 

 Border, Add All edges 

 Border, Add Left 

 Border, Add Top 

 Border, Add Right 

 Border, Add Bottom 

 Highlight all stitches in chart that match currently 
selected stitch in palette. 

  

Some toolbar buttons might be disabled, meaning that action cannot currently be performed. For 

instance, the Paste  toolbar button is disabled if there is nothing in the buffer to be pasted.  You'll see 
some of these same icons next to items in the menus – those have the same operation as the toolbar 

button. 
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Status Bar Information 
The status bar is at the very bottom of the main window, and shows you some useful information as you 
work with your chart. See Figure 12: Status Bar.  
 

 
Figure 12: Status Bar 

 

On the very left of the status bar is the stitch that was last selected from the Stitch Palette.  This is useful 
because the list of stitches in the Palette is very long, and the currently selected stitch might not be 

visible on the screen. 
 

On the far right of the status bar is the font size currently in use. This number is in points. A 14pt font is 

as small as you can make the chart font in Knit Visualizer (otherwise you wouldn't be able to see any of 

the symbols!)  If you play around with the Increase Font , and Decrease Font  buttons, you'll see 
this value change.  If you wanted to pair two charts next to each other in a pattern (but not physically in 

the same chart), and make sure the cells were the same size, you'd check to make sure the font size was 

the same in both.   The font size is saved as part of the chart, so whatever you select before you save 
the chart is what will be used when you re-open it. 

 
To the left of the Font Size, is the size and type of the current selection.  For more information on 

selections and how to use them, see the Selections section below. 
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Knit Visualizer Modes 
If you were reading carefully*, you'd have noticed that there are two toolbar buttons that let you switch 

between the different modes in Knit Visualizer.  The arrow  is selected when you are in Select Mode.  

The paintbrush  is selected when you are in Painting Mode.   There is also a third mode, but one that 

doesn't have a toolbar button, because it's a special case:  Parsing Mode.  You use the Pattern Entry 
portion of the screen for typing in pattern rows and automatically generating symbols into new rows in 

the chart. 
 

You can switch between modes in several ways.  To enter Select mode, do one of the following: 

• Click on the Select Mode  button 
• Click on the chart's row numbers, or the chart's column numbers 

 
To enter Paint Mode, do one of: 

• Click on the Paint Mode  button 
• Click on a symbol in the Stitch Palette 

 

Knit Visualizer automatically puts you in the correct mode if you click on a stitch in the Stitch Palette, or if 
you click any of the row/column number headers.   

 

You can easily tell which mode you are in because the mouse cursor changes to 

a paintbrush in the chart area when you are in Paint Mode and the appropriate 

mode button in the toolbar will be selected. 

If you find that you have accidentally switched modes because you clicked in one of the areas mentioned 
above, simply click the correct Mode button in the toolbar to switch back.  If you accidentally painted a 

stitch, use Undo (Control-Z) to remove that stitch. 

 

Select Mode 
The first mode (and the most intuitive for most computer users) is Select Mode.  There are three types of 
selections in Knit Visualizer.  The status bar will give details on the size and type of the current or most 

recent selection. 

 

 Cell Selection Once in Select Mode, click and hold in the first cell, 

then drag your mouse to add to the selection. The 
cells selected are highlighted in a different color.  

Check the status bar for details on the size of the 

selection 

 Column Selection Click on a column header, hold, then drag to select 
multiple columns 

 Row Selection Click on a row header, hold, then drag to select 
multiple rows 

 

                                                
* You didn't know there'd be a test, did you? 



Knit Visualizer 1.2a Manual   Page 34 of 47 

Copyright 2005 -2007 © The Knit Foundry 
http://www.knitfoundry.com 

We've already covered the details of using Copy, Paste, Cut, Insert & Delete when going over the Edit 

Menu.  Knit Visualizer will give you a message if you try to Paste or Insert the wrong type of buffer into 
the wrong type of selection.  Remember, there is always the Undo (Control-Z) feature to back out of the 

operation you just performed. 
 

 

Once a stitch has been painted into the chart, it can now be "split up" by doing 
a delete, cut or paste through it.   This is allowed for maximum flexibility when 

designing your patterns.   Be careful to not chop up your stitches that are wider 

than one cell, unless you only want to knit the first few stitches of it. When the 
Legend is generated it will include that stitch and the knitting instructions for it 

even if only part of the stitch is present.  This chart has the top cable that is still 
"complete" and the bottom cable has been split by a purl stitch being 

painted/pasted into the middle of it: 

 
 

 

Paint Mode 

You enter paint mode by clicking on the paintbrush  toolbar button, or by selecting a stitch from the 
Stitch Palette.  The Stitch Palette contains all the different stitches you can use in your chart.  Each stitch 

is comprised of one or more cells.  You can see exactly what the stitch looks like by its entry in the Stitch 

Palette.  Once you select a stitch you can then paint it by simply left clicking on the chart at the desired 
location. The new stitch will be painted from that cell and out to the right.  The currently selected stitch 

(which is what will be painted) is shown on the far left of the status bar. 
 

If you want to paint the same stitch many times all in the same area, you can hold down the Shift key, 
then left click and drag. Every new cell you touch will have the stitch painted into it (and in the cells to 

the right, if the stitch spans multiple cells). The Undo command will undo the entire paint operation when 

you are painting the same stitch many times using the Shift Key. 

Navigating the Stitch Palette 
The stitch palette is organized into groups of stitches, to make it easy to find the stitch you need.  If you 

aren't interested in a group of stitches, you can hide that set by clicking on the title of the group.  (See 
Figure 13).   
 
To select a stitch, simply left click on it. It will now become the highlighted stitch, and you should see 

that stitch on the bottom left of the status bar.  Any stitch previously selected will be unselected. You can 

only select one stitch at a time in the Stitch Palette.  When you select a stitch in the palette, Knit 
Visualizer will be automatically put into Paint mode. 
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Figure 13: Stitch Palette with several groups closed 

 

In Figure 13, The Increases, Decreases & Misc groups are all closed.  To open them again, simply click 
again on the title bar for that group.  

 

Each stitch comes pre-defined with a set of knitting instructions on how to make that stitch.   You will see 
these instructions in the Legend in the Preview window or you can view this from within the Stitch Palette 

by holding your mouse steady over the stitch name. 
 

If you'd like to see all instances of a stitch highlighted in the chart, select it in the Stitch Palette and click 

the Highlight Stitch  toolbar button.  Those stitches aren't a selection (you cannot copy and then paste 
them), the highlighting is just a visual indicator to allow you to find them easier. 
 

Pattern Entry Mode: Parsing Knitting Instructions 
The Pattern Entry mode is an advanced mode in Knit Visualizer that helps you build a chart from a stitch 
pattern.  All knitters seem to have extensive libraries of pattern books, stitch patterns and magazines.  

Not all of those pattern sources contain charts; but they do contain written out instructions.  By using the 
Pattern Entry mode, you can create a chart from the written out instructions.  You should treat this 

section of the Manual as more of a tutorial. It will be helpful to follow along by entering the example 
pattern instructions into Knit Visualizer, see what happens, and play around to see what changing 

different options does 

 
The brains behind the Knit Visualizer's Pattern Entry function is the Parser.  It reads what you type in, 

tries to understand it, then adds a row to your chart based on what it thinks you said.  It's a bit like 
typing in German and getting English back out.  Sometimes it won't know what you are saying and will 

give you a message that tells you where it became confused.  There is no possible way for the manual to 

cover all the combinations you can enter in the parser; as the combinations are in some ways, endless.  
The parser might also be modified in future patches to parse additional combinations of stitches.  We will 

cover the basics here to get you started. 

What Can Be Parsed 
The basics consisting of: knits, purls, most decreases & increases.  Cables are difficult because there is 

no common syntax used to specify the same exact cable between different books.  The best thing to do 
is to use the Paint Mode to fill in cables.  This has the added bonus of letting you see which way the 

cables turn and you get a much better visual idea of how the pattern will look knit up. 
 

There are several ways to specify repeats within a pattern row (see details in sections following).  The 

parser was designed to parse most of the Barbara Walker Treasuries patterns, with the exception of cable 
stitches.  The parser does understand the cable specification formats used in Nicky Epstein's Knitting On 
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the Edge and Knitting Over the Edge books.  (E.g. 2/2rpc)   The best rule of thumb if you get an error 
back from the parser is to always check for typos first, and then check for odd stitches.  

Pattern Entry Area 
The pattern Entry area is where you enter the text of the knitting instructions, and specify the options 

that will help the software determine how to perform the translation. The pattern entry area of the 
screen is shown in Figure 14.  

 
Figure 14: Pattern Entry 

 

You enter one row at a time in the Pattern Entry section.  The options above the Text field tell the Parser 

what type of row to expect.  Starting from the top left: 

1. Mode: Circular or Flat.  Circular will mean we are always entering a Right Side Row.  

Selecting Flat means we need to specify if the row is RS or WS.  The parser will flip this back 
and forth for us as we enter rows. 

2. Right Side Row: If this box is selected, then you are entering a Right Side Row.  Ignored if 
Circular is selected. 

3. Stitch Count: How many stitches will this row consume? This should match the number of 

stitches in the row you already entered.  The parser automatically adjusts this value for you 
as you enter new rows*.  This is very important if there are repeats in the pattern, and you 

want the parser to fill across the size of your chart.  You can type in a value, or click on the 
arrows to change the value. 

4. Text: The area where you type (or paste in) the pattern text (  You can use the up/down 
arrow keys to change the Stitch Count while typing in text) 

5. Add Row #: Button to click when the pattern text is ready to be parsed (  Pressing the 
Enter key in the Text box does the same thing) 

6. All k: A quick method to enter all knit stitches. Uses the value in Stitch Count for quantity of 

stitches. Clicking this button is equivalent to typing in [k] and clicking Add Row #. 

7. All p: A quick method to enter all purl stitches. Uses the value in Stitch Count for quantity of 

stitches.  Equivalent to [p] 

8. All x: A quick method to enter all No Stitch (Empty) stitches. Uses the value in Stitch Count 

for quantity of stitches. Equivalent to [x]  

 

As you enter pattern rows, it is important to keep an eye on these values to make sure they are what you 
expect.  Sometimes just the Right Side Row checkbox being set incorrectly will give you very different 

                                                
* Sometimes you don't want this to be the exact number of the row already entered.  There are cases 

when entering repeats that the number of stitches specified after the repeat is excessively long.  For 
instance: k2 k2tog *yo ssk k1 k2tog yo sl2knitwise k1 p2sso rep from * end yo ssk k1 yo ssk k2.  The 

repeat is calculated before the parser sees the stitches after the "end"; and then tacks all those stitches 
on.  When you see the chart it will be obvious it added a few extra stitches. 

4     

    1 2 3 

5     

6 

7 

8 
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results!  Before following along in these examples, please verify your Chart Properties are set to the 
following: Circular Knitting OFF, Odd # Rows on Right ON, Hide Wrong Side Rows OFF. 
 

The parser ignores all punctuation (commas, semicolons, etc) & most white space (with some notable 
exceptions).  You can type upper or lower case letters. 

Simple Parser Example 
If you have selected "Flat" knitting, after you enter a row, the parser will change the state of the Right 
Side Row checkbox.  For instance if you start with "Flat" selected, and Right Side Row selected. You are 

telling the parser you are entering a pattern that was written for knitting back and forth, and the row you 

are going to type in is a right side row.  Stitch Count is set to 10. You then type in  
 

k2 p2 yo k2tog p2 k2    

 

and press the Enter key.  The parser adds the first row to the chart: 

             
Figure 15:  A Simple row entered via Parser 

 
Now, the Right Side Row checkbox is automatically unselected, in preparation for the next row. Also the 

button Add Row# now has the text "Add Row #2". Hit Enter a few more times to see what happens.  
Notice how the Right Side Row checkbox keeps turning itself off and on, and the Symbols entered for the 

Wrong Side rows are different than those for the Right Side Rows.  Also the Row # in the Add Row 

button increments to tell you what the next row will be. 
 

Now you can use the Undo key (Control-Z) to remove those rows you just added, until there is only one 
left.  The Add Row # button adjusts, but the Right Side Row checkbox doesn't check/uncheck during the 

Undo. This is because the parser assumes you are Undo-ing an error in the last entry, and that error 

might have been selecting the wrong type of row.  It doesn't want to guess wrong, so it leaves it alone.  
The lesson in this is always check to make sure the Right Side Row checkbox is selected/unselected as 

you want it. 
 

IMPORTANT:  There are limitations to what the Parser can understand.  There 

are so many different ways of representing the same basic knitting stitches, 
that it would be impossible to understand them all.  The more complex the 

pattern, the less likely you will be able to enter it exactly as written.  It is best to 

start with very simple examples, understand how the parser thinks (believe me, 
it has a mind of it's own) before moving on to more complex patterns.  This 

section will give you ideas on how to make it understand the pattern you want to 
enter, but there are no guarantees.  It is possible the parser will pretend to 

understand the pattern, but spit out a different stitch than you think it should. 

Always check your chart! 

Entering Repeats 
The parser can understand repeats and how to use them to fill out an entire pattern row.  When entering 

stitch patterns via the parser, it's best to do at least two repeats worth so you get an idea of how they 
work together.  Let's say we are working on the Lace Puff pattern from Barbara Walker's A Second 
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Treasury of Knitting Patterns (page 283)*.  That pattern is a Multiple of 12 sts, plus 2.  That means there 

are 2 edge stitches, and 12 stitches in each repeat. If we want to enter this pattern, we should execute 
Edit -> Clear Chart if another chart was present and set up the Parser as follows: 

 Stitch Count: 26 (We get this number from adding 12 + 12 + 2) 
 Mode: Flat 

 Right Side Row: Selected 

 Text: k1 * ssk k3 yo p2 yo k3 k2tog rep from * end k1 

 

Resulting Row: 

 
 

If you happen to have the BW books, you'll notice that the actual text in the book was this: 

 K1, * ssk, k3, yo, p2, yo, k3, k2 tog; rep from *, end k1 

The parser ignores all those commas, so there's no point in typing them in. We leave the spaces for 
clarity, although habit made me leave out the space in the "k2 tog" because I normally type k2tog. Either 

will be recognized by the parser.  For the parser to recognize the * rep from * repeat, you must include 
the single spaces the the "rep from *" portion of the pattern. Given that adding spaces is a natural 

tendency, this shouldn't be a problem; but it is something to keep in mind. 
 

The Stitch Count you enter is important because it tells the parser how many times to repeat the stitches 

in between the repeat indicators.  If you accidentally enter 27, 28 or even 29; it's Ok, the parser will 
probably make a good guess and still only create 26 stitches.  It's not until you get up to 38 (which is 3 

repeats + 2 edge stitches) that it will actually create 3 repeats in the chart.  If you don't get the number 
of repeats you expect, you can always use Undo, change the # of stitches and try again. 

 

There are multiple ways to specify repeats, and the parser doesn't care which one you use.  A lot of 
patterns use the * <stitches> rep from * syntax, but you might also see it written like this: 

 

k1 ( ssk k3 yo p2 yo k3 k2tog ) end k1 

 
The means exactly the same thing as the original text. We've changed the first * to a ( and the rep from 

* to a ).  You can use pairs of parentheses () or square brackets [] or curly braces {} all in the same 

fashion.  Make sure you always use them in pairs; as the first one tells the parser, "Attention, I'm going 
to enter some stitches to repeat" and the second one says, "The repeat is finished now, take all those 

stitches and repeat as indicated".  If one of them is missing, as in this line: 
 

k1 ( ssk k3 yo p2 yo k3 k2tog end k1 

 

you'll see an error message like this one: 

 
Figure 16: Parser Error Dialog 

Whoops! Click Ok, and go back to fix the text.  Verify that the Right Side Row checkbox is selected before 

re-adding the row. 
 

                                                
* You'll find the complete chart for this pattern in the Sample Charts directory, named 
LacePuff_BW2_pg283.kct 
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Let's continue entering the Lace Puff pattern.  We've successfully entered the first Row.  Verify your 

settings: 
Stitch Count: 26  (We get this number from adding 12 + 12 + 2) 

 Mode: Flat 
 Right Side Row: UNSelected 

 Text: k1 *p2tog p2 yo k4 yo p2 p2tog-b rep from * end k1 

 

After entering the second row, the chart now looks like: 

 
 

Row 3: RS row, Text: k1 *ssk k1 yo p6 yo k1 k2tog rep from * end k1 

 

And so on, until you have finished all 8 rows in the pattern.  Edit the Chart Properties, and enter the title 
(Lace Puff) and the source (BW#2, pg 283) and whatever notes you'd like. Make sure and save your 

work! The finished chart looks like this: 

 
Figure 17: Lace Puff Chart for Flat Knitting 

 
When I created this image in the Preview Dialog, I selected Horizontal Layout, Turned Simple Legend On 

to remove the stitch instructions, and didn't show any notes.  I used Copy to Clipboard to bring the image 

into this document. 
 

If you look at the picture in the Barbara Walker book, you'll see that this image matches very closely to 
the actually knitted item!  If you'd like to convert this chart to knit something circularly, all you need to 

do is remove the outer two columns, which are edge stitches for when it is knit flat; and change the 

Chart Properties dialog to select "Circular" (modifying the location of the row numbers in the chart): 
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Figure 18: Lace Puff Chart for Circular Knitting 

 
Remember that there are two full repeats shown in Figure 18.  You might want to indicate the repeats by 

using borders, as shown in Figure 19. 

 
Figure 19: Lace Puff using Borders to show repeats 

 

A Few Caveats 
The parser will also automatically change the Stitch Count to match the last row you entered.  95% of 
the time this will work and you won't have to think about it.  Every once in a while a row will be entered 

that will be way too long for what you really want.  This is due to the way it counts repeats and adds on 
stitches after the repeats are completed.  Usually it means one too many repeats has been entered. You 

can use Undo, then change the Stitch Count to a smaller value, making sure the Right Side Row 
checkbox is set correctly, then hitting Enter.  

Quantified Repeats 
In many patterns, there will be a grouping of stitches and a quantity to tell you how many times to work 
those stitches.  From another pattern, that has a Multiple of 10 sts plus 2: 

 Stitch Count: 22 

 Mode: Flat 
 Right Side Row: Selected 

 Text:  k1 * (sl1 wyib, sl1 wyif ) twice, sl1 wyib, p5 rep from * end k1 

 

In this pattern, the * indicates that a repeat is starting.  The ( indicates another repeat is starting.  After 

the end ) is found, the parser sees the text 'twice', it knows to take the stitches in between the 
parentheses and use them two times.  Then the parser continues reading the text and sees "rep from *". 

It knows that repeat is now completed; and fills out the remainder of the chart, ending with a single knit 
stitch. 

 
Here are some examples to get you used to what style of quantified repeats the parser will accept: 

 ( p2 k2) twice 

( p2 k2 ) 2 times 
 [ p2 k2 ] 3 times 

 [ p2 k2 ] once 
 { p2 k2 } 1 times 

Remember, you can combine different types of repeats by nesting one repeat inside another like this: 
 [ p1 (k1 yo) 3 times ]  
Make sure that you don't confuse the end parens though. This would be incorrect 

WRONG: [ p1 (k1 yo] 3 times ) 
The parser will give you an error as it must finish the () repeat before it can finsh the [ ] repeat. 
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Changing the way the last repeat of the row ends 
Often the very last repeat of a pattern row is slightly different for whatever reason.   To change the last 
repeat you can do this: 

 

p4 *yo p2tog p9 p2tog-b yo p7 rep from * end last repeat p4 

 

Make sure and type in "end last repeat" just like that with only single spaces.  This is one of those cases 
that the parser requires the spacing to be absolutely perfect. If you add an additional space it will get 

confused and not know what to do.  Many of the patterns in Barbara Walker's books use this type of 
syntax. 

 

Basic Stitches 

This section will go over most of the basic stitches you can enter.  

 
The following are all equivalent: 

kkkk 

k4 

knit 4 

 
or using purls 

pppp 

p4 

purl 4 

p2p2 

 

sl1  (slip 1) 

sl3 (slip 3 stitches) 

sl wyif 

 

sl wyib (same as a normal slip stitch) 

k tbl 

p tbl 

k in st below 

p in st below 

 

x  (empty stitch) 

Increase & Decreases 
yo 

m1 

m3  (puts three m1 stitches right next to each other) 

 

knit purl knit in 1 stitch 

 

k2tog 

k2tog tbl 

ssk 
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k2tog b (same as k2tog tbl) 

p3tog 

k3tog 

p3tog tbl (the parser does NOT like p3tog b even though this should mean the same thing) 

 

sl1 k2tog psso 

sl1 p2tog psso 

 
There are so many combinations/variations of sl1 <stitch> psso that it's impossible to have symbols for 

them all.  There are a few provided in the Stitch Palette that you can use if you like them. 
 

Special Stitches 

cluster2 

cluster5 (and all those in between. Won't go larger than 5) 

 

mb (means Make Bobble) 

 

Cables 
The parser understands cables that follow this syntax: 

 cXoverY<l/r>[pb] 
 

Read this as "Cable X stitches over Y stitches To the Left/Right (With Purl Background)". Some examples 
will help clarify this: 

Parser  Stitch Palette Meaning 

c1over3l 1 over 3, left Cable 1 over 3 stitches, leaning left 

c1over3r 1 over 3, right Cable 1 over 3 stitches, leaning right 

c3over2rpb 3 over 2, right P Cable 3 over 2 stitches, leaning right with a purled 

background 

c4over1rpb 4 over 1, right P Cable 4 over 1 stitches, leaning right with a purled 

background 

 
If you specify "pb" at the end, the instructions and symbol will have purled stitches behind the cable.  

Using l for left means the cable crosses to the left, Using r for right means the cable crosses to the right. 

  
When entering patterns that have cables, the parser will most likely not understand the format used in 
your pattern.  If you can't easily substitute the above syntax for cables for what the pattern specifies, use 

a number of No Stitch cells to be place holders for a cable (x4 or x8), and then paint the cable in later 

from the stitch Palette.  Cables in Knit Visualizer can go all the way up to 4 over 4.  The parser will 
understand larger cables, but there aren't symbols to display for them. You'll see a bunch of question 

mark symbols in the chart where the cable would be. 

How to Handle Non-Pattern Instructions 
 

"Knit all the knits, Purl all the Purls" 

Simply copy the last row worked, and Duplicate (Control-D) it to the top. 
If you do this every other row (where you'd be doing Wrong Side rows), make sure "Circular" is selected, 

and "Right Side Row" is selected, then you can simply hit ENTER twice to enter the same row again.  If 
there are more than just purls and knits in the row, use the stitch palette to fill in the correct stitches 
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"See Row X" or "Same as Row X" 

Select the Row indicated by clicking on the row number (either to the right or left of the row) and 
Duplicate (Control-D).  The works when the pattern row is for the same side both times. This won't work 

if Row X is a wrong side row, and the new row is a right side row. Then you'll have to type in the pattern 
instructions for that row again so that Knit Visualizer can parse it as the correct side row. 

 

"Row X: Knit" 
This really means knit ALL stitches, not just knit one stitch. Make sure the stitch count is set correctly, 

and then press "All k" button. Or you can type in "[k]" or "(k)" into the Instruction Field.  The same 
applies for rows that should be all Purl stitches.  

 
You can create a bunch of blank rows at the top of the chart easily, but pressing the "All x" button. Each 

time you press this, it will create a row that contains the "No Stitch" placeholder.  You can then paint 

stitches with the Stitch Palette. 

How Many Repeats To Enter 
When entering a pattern that has repeats, it's a good idea to enter at least two repeats.  For instance if 

your pattern is a "Multiple of 8 sts plus 1", you should enter "17" for the Stitch Count field.   This is very 
useful if you don't want to start the repeat in the same place the pattern did.  Looking at multiple repeats 

across (and down) will help you see it in a different way.   

Keeping Track of Which Row Comes Next 
The "Add" button will always tell you which row is the next one to be entered. This is true if you type in a 

row, or select one and Duplicate it using Control-D.  If you copy and paste a full row into the middle of 
the chart, the button will adjust itself to use the next number in line. 

 

Always check the "Right Side" checkbox to make sure it matches which side you are trying to enter next.  
If you enter one, and Undo (Control-Z), it doesn't modify the checkbox's status. 

Parser Limitations 
It is impossible to know all the different names for knitting stitches in the various books & patterns. Knit 
Visualizer has tried to come up with a good standard set to use, along with quite a few aliases for some 

stitch names. (For instance you can enter either ktbl or k-b or kb) 

What To Do When Things Look Really Wrong 
If you get an error message, you are entering something the parser doesn't understand, or it's possible 

you had a typo when you entered the pattern row.  You could have the wrong number of stitches in the 
Stitch Count field.  The Right Side checkbox might have been selected when it shouldn't have been.  Use 

Undo (Control Z) to remove the last row entered, and verify the text you entered, then try again.  
Whenever using Undo or Duplicate always check to make sure the Right Side checkbox is selected 

correctly for the next row. 

 
You might also see a question mark symbol in the chart. That means the parser recognized something 

that looked right, but it didn't know what symbol to assign to it. 

Parsing vs The Stitch Palette 
There are stitches on the palette, that you won't be able to put on your chart by parsing text.  An 

example is "yo twice".  This, and other stitches are included in the palette so that you can include it in 
your charts.  If you find a strange stitch in your pattern instructions that the parser doesn't understand 
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it's best to enter a place holder for them.  You can use any stitch you want, but it might be easiest to find 

those placeholders by using something not commonly included in your patter such as the empty stitch: 
 

k5 p2 x5 p2 k5 

 

Here we've put in 5 empty stitches for a 5 stitch cable. The parser will include the empty stitch as place 
holders, and we can paint the appropriate looking cable on top of them once we get far enough into the 

pattern to decide what will look best. 

Tips and Tricks 
For more tips and tricks, please see our website http://www.knitfoundry.com/software.html 

 
• To generate the pattern text for your chart, click on the Print button. You'll see the Preview 

window and one of the elements in that window is the pattern text. You can print it directly from 

there, or if you'd like to get just the text for the pattern for another document, select the pattern 
text using your mouse cursor and type Control-C  to copy.  Change to the other application 

(either notepad, MS Word, or other word processing software) and then type Control-V 

 
• To include your chart in a pattern where you want the legend in a separate location than the 

chart, export one image file with only the chart, and one image file with only the legend. You can 

then move them around independently to work with whatever formatting your pattern uses. 
 

• Remove all borders in the whole chart: Click on the "Select" Arrow to enter select mode; then use 

Control-A to select all cells in the chart.  Click the Borders – None button.  

 
• To fill an area very quickly with all purl stitches, or all knit stitches (or any stitch), copy a single 

instance of that stitch, then select the area to fill.  Paste (Control-V), and the area will be filled. 

 
• Does your chart look fuzzy when you paste it into another document? (either via Copy to 

Clipboard or Export to PNG)  Usually this means the other application is making the chart larger 

than it was originally created.  It's best to try and get the font size in Knit Visualizer as close as 
possible to where you want it for your other document.  Otherwise we recommend making the 

font larger, then sizing the chart down in your other document. 

 
• Switch between Select and Paint mode quickly using the S key.  If you're in Paint mode, tap S 

and you're in Select mode.  If you're already in paint mode, tap S and you're in Select mode now.  

This tip will only work if you are NOT currently typing into the pattern entry field. 
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Quick Reference: Keyboard Shortcuts 
 

Command Key Sequence Description 

Application 

Preferences 

Control-, Shows dialog letting you edit Application wide 

preferences 

Copy Control-c Copies current chart selection 

Cut Control-x Cuts the current selection to the buffer; and 

replaces it with blank stitches in the chart 

Decrease Font Control-- Zoom out; decreases the font size of the chart  

Delete Delete Deletes the current selection (not copied to 

buffer) 

Duplicate Control-d Only works when selecting Cells or Columns; 

Duplicates & inserts the selection at the top of 

chart for rows, and at the right of the chart for 
columns 

Duplicate Control-d Duplicates the row or column selection to the top 

or right side of the chart. 

Increase Font Control-+ Zoom in; increases the font size of the chart 

Insert Control-i Inserts a full row or column that was previously 

copied into the buffer 

Paste Control-v Pastes buffer 

Redo Control-y Redo the last Undo action 

Save Control-s Save the current chart. If filename has already 
been assigned it will save again in the same 

place. 

Undo Control-z Reverses the last chart action (Edit, insert, etc) 

Paint 
Continuous 

Shift-left click, 
held down 

Paints the same stitch over each cell the mouse 
is dragged over while both shift and the left 

mouse button are held down 

Show Chart 
Properties 

Control-[ Shows the Chart Properties dialog 

Border Top Control-T Adds border on the top edge of the selection 

Border Right Control-R Adds border on the right edge of the selection 

Border Left Control-L Adds border on the left edge of the selection 

Border Bottom Control-B Adds border on the bottom edge of the selection 

Border All Control-; Adds border around all edges of the selection 

Border None Control-0 Removes all borders within all cells of the 
selection 

New Chart Control-N Opens the New Chart dialog 

Open Chart Control-O Prompts you to open a file containing a chart 

Show Preview Control-P Lets the user view the Preview dialog and from 

there Print or Export to an image file 

 

 
Print this page for a handy reference! 
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Where to go for Support 
Yahoo group: knit-visualizer-users@yahoogroups.com 
You can join this group by visiting: http://groups.yahoo.com/group/knit-visualizer-users 

 
This forum is monitored by The Knit Foundry. Additionally you can send email to 

support@knitfoundry.com.  It might take us a while to get back to you; but we do read all comments and 

suggestions.   
 

Other Resources 
There are a lot of books on knitting charts.  First and foremost are the Barbara Walker Treasuries.  While 

not all of these books cover charts, they are a great resource for stitch patterns. Knit Visualizer 
extensively used the patterns in these books to test and build the Pattern Entry parser. 

 

A Treasury of Knitting Patterns 
by Barbara G. Walker 

Published by: Schoolhouse Press 
ISBN: 0942018168 

 

A Second Treasury of Knitting Patterns 
by Barbara G. Walker 

Published by: Schoolhouse Press 
ISBN: 0942018176 

 

Charted Knitting Designs: A Third Treasury of Knitting Patterns 
by Barbara G. Walker 

Published by: Schoolhouse Press 
ISBN: 0942018184 

 
A Fourth Treasury of Knitting Patterns 

by Barbara G. Walker 

Published by: Schoolhouse Press 
ISBN: 0942018206 

 

Online Resources 
Knit Foundry has a tutorial for reading charts and knitting from them.  

http://www.knitfoundry.com/freestuff.html 
 

Kim Salazar at her string-or-nothing blog, wrote an excellent series of tutorials on charts & creating them 
from patterns.  The first tutorial is here: http://string-or-nothing.blog-city.com/charting_101.htm 
A lot of what she describes in her tutorials, Knit Visualizer does for you, but it's very useful to understand 

the concepts. 
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